Survey Analysis Workshop
Block 2: Analysing one variable

2.3.1.2a1 Select and rename variables exercise

Previous sessions:

Copyright © 2013 John F Hall
2.3 Data transformations
[Draft only: 5 June 2013]

2.3.0 Preliminary file downloads
2.3.1.1 Data transformations

Exemplar: British Social Attitudes 1986

File: bsa86.sav

New commands:

GET FILE ... /KEEP

RENAME VARIABLES

Utilities > Variables

Data > Define Variable Properties

Task: a) Retrieve file bsa86.sav
b) Select out demographic variables v1510 v1511 and v1512 and rename them.

Old name New name
v1510 marital
v1511 sex
v1512 age

c) Correct the measurement levels
d) Add variable and value labels.

Step 1. Retrieve the SPSS saved file.

If you have already downloaded file bsa86.sav from this site and saved it to a memory stick as
e:\weebly downloads\bsa86.sav skip to Step 2 on page 4. Otherwise download it now.

Go to page 2.3.0 Preliminary file downloads, right-click on file bsa86.sav and follow instructions to:

| Open in a New Window | .

It will probably download in so change to | Variable View |.

#2 bsaB6.sav [DataSetd] - IBM SPSS Statistics Data Editor E@

File Edit View Data Transform Analyze Direct Marketing Graphs Utilities Add-ons Window Help

SHeMc BLERBUBLE S100 %

Name Type

version Numeric

v209 Numeric
v210 Numeric
V212 Numeric

v213 Numeric

D | a|w -

Width | Decimals Label Values Missing Columns |  Align Measure Role

1 0 QUESTIONNAIRE VERSION ADMINISTERED {1, VERSION A}... None 8 =Right ¢ Scale S Input

1 0 Q1A R READS NEWSPAPER 3+ TIMES PER WEEK {0, SKIPPED}... 8,9 8 =Right ¢ Scale “ Input

2 0 Q1B [IF READS 3+ TIMES] WHICH PAPER 10, NO PAPERY}... 98, 99 8 =Right & Scale ~ Input

1 0 Q2A POLITICAL PARTY SUPPORTER {0, SKIPPED]... 8,9 8 =Right  Scale S Input

1 0 Q2C [IF NOT SUPORTR] CLOSER TO ONE PARTY {0, SKIPPED}... 8,9 8 Right & Scale “ Input
n N8 & N_&. PARTY NEN A QR QN R\/A Q8 Q0 2 Riah &£ ala nn

Data View ' Variable View

IBM SPSS Statistics Processor is ready

bsaB86.sav as downloaded

Explore the file if you want to, then:



http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/2.3.0__preliminary_file_downloads.pdf
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/2.3.1.1__data_transformations.pdf
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/bsa86.sav
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/bsa86.sav
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/bsa86.sav
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/2.3.0__preliminary_file_downloads.pdf

File bsa86.sav is 2.05 mb. Insert a stick with sufficient capacity in drive e: and create a new folder
weebly downloads. Check that destination folder e:weebly downloads is empty:

[ |

@v‘ | » Computer » COOLMATE (E) » Weebly downloads

- | +3 ‘ | Search.. P |

Organize ~ Share with ~ New folder

- O @

Name
& Computer

& Local Disk (C)

<> COOLMATE (E)
= Removable Disk
€3 Elements (G:)

«» SANDISK (L) -

Date modified Type Size

This folder is empty.

Go back to the SPSS Data Editor:

Fic Edl View Dato Transform Analyze DiectMarketing Graphs Utiiies Add-ons Window Help
New »
. i 8 B Bl S0 )
lcimals Label | Values | Missing | Coumns| Align | Measure = Role |
Open Database QUESTIONNAIRE VERSION ADMINISTERED {1, VERSION A} None 8 =Right & Scale  Input
© Reog Text Data.. Q1A R READS NEWSPAPER 3+ TIMES PER WEEK (0, SKIPPED) 809 8 =Right #Scale  input
8 Close R Q1B [IF READS 3+ TIMES] WHICH PAPER {0, NO PAPER]... 98, 99 8 =Right #Scale ™ Input
W Save kS Q2A POLITICAL PARTY SUPPORTER (0, SKIPPED)... 809 8 =Right £ Scale ™ Input
Save As.. Q2C [IF NOT SUPORTR] CLOSER TO ONE PARTY {0, SKIPPED). . 89 8 =Right #Scale  Input
I Save All Data 028 2 20 8 2F DARTY INENTICELCATLOMELILLL 11 _CONSERVATIVMEL 08 o0 8 = Dinht__&# Srala Il i 0
& Export to Database. .
%@ Mark File Read Only
= |IBM SPSS Statistcs Processor is ready [T J
L' mf Rename Dataset...

File > Save as:

and navigate to e:weebly downloads:

Wvll, » Computer » COOLMATE (E) » Weebly downloads

| 6| search weebiy downtoa.. O |

Lookin: | . COOLMATE (E) =] e EaE

Organize ~  New folder

| JFHfiles

& Favarites = Name : Date modified Type
%5 Recent Places
J Downloads
17 Dropbox

Ml Desktop

No items match your search.

2 Libraries
% Documents.
& Music
5 Pictures -4 m

Size

Keeping 631 of 631 variables.

File name: ‘DSEBG,SB\I

Save astype: |SPSS Statistics (*.sav)

.wme variable names to spreadsheet

File pame:

Save as type: [TXT File

[ ] Save value labels where defined instead of data values
| [l Save value labels into a sas file

‘= Hide Folders

Store e To Repostory..|

Check that the file name is |bsa86.sav |, then click on [Save}:

F=mfo x|

@-p » Computer » COOLMATE (E) » <[4+ |[ search.. P}
Organize ~ Share with ~ Burn New folder BEE ~ O e
;; Favarites Name Date modified Type Size

% Recent Places ). JFH files 04/04/201313:07  File folder

M Deskiop bsad6 09,/04/2013 06:20 SPSS Statistics Dat.. 2,053 KB
Iy Downloads

%7 Dropbox -

Close file bsa86.sav and exit from SPSS.

End of Step 1.



[Note]
Variable names and labels

I have renamed the variables in bsa86.sav (the saved file for the 1986 wave in 2.3.0 Preliminary file
downloads) from the original mnemonic names to my preferred positional variable names as this
makes it easier to work direct from the original questionnaire (see:1.3.1 Conventions for naming
variables in SPSS). However, the file still has the original UPPER CASE variable labels and value
labels written in 1986 by John Curtice and Ann Mair using a much earlier version of SPSS. Given the
limit in those days of 40 characters for variable labels and 20 for value labels (only 16 for column
headers) writing them then was quite tortuous (as is reading them now).

In later versions of SPSS the limits on number of characters in labels have been almost totally
relaxed, so it's best to build up your own SPSS syntax and saved file(s) with Mixed Case labels, as in
the tutorials, exercises and specimen answers. You should try the exercises yourself before looking
at my specimen *.sps files. They are there as a crib (or as backup) not for you to copy and run,
otherwise there's no point in you taking the course. See entries 2.2.1.210 2.1.2.5

Downloaded *.sav and *.txt files

The screenshots in the following steps assume that all files were downloaded to weebly downloads
on a USB stick in drive e: as per instructions in 2.3.0 Preliminary file downloads

If all files have been correctly downloaded, folder e:weebly downloads (sorted by Type) should look
something like like this:

ESN =X
@Ov| | » Computer » COOLMATE (E) » Weebly downloads - | +4 | | Search.. P |
Organize ~ Share with ~ Burn New folder = - _IJ 9
i Name Date modified Type Size
& Computer .
) uﬂ bsa86 05/06/2013 12:.07 SPSS Statistics Dat... 2,053 KB
& Local Disk (C) =
ua fifthx 05/06/2013 12:20 SPSS Statistics Dat... 61 KB
> COOLMATE (E) : i .
!,IB myclass 05/06/2013 12:21 SPSS Statistics Dat.. 7KB
| . Weebly downl =
. u,-a newbsag9 05/06/2013 12:19 SPSS Statistics Dat... 3,273 KB
> Removable Disk— E o
\,ﬂ gl4gb1975 03/06/2013 19:37 SPSS Statistics Dat... 601 KB
& Elements (G)  |=
B bsa86 05/06/2013 09:43 TXT File 3,304 KB
> SANDISK (I) _ -
— bsa89 05/06/2013 11:17 TXT File 3,824 KB
> FASTTAB (K) i .
myclass 05/06/2013 11:17 TXT File 7 KB
8 items
|

More files will be added from subsequent tutorials and exercises, but things can be kept manageable
by creating sub-folders for each study and/or for each topic.



http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/2.3.0_preliminary_housekeeping.pdf
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/2.3.0_preliminary_housekeeping.pdf
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/1.3.1_conventions_for_naming_variables_in_spss.pdf
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/1.3.1_conventions_for_naming_variables_in_spss.pdf
http://surveyresearch.weebly.com/block-2-analysing-one-variable.html
http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/2.3.0__preliminary_file_downloads.pdf

Step 2: Selecting variables for analysis

The following assumes you are starting SPSS from scratch.

If you navigate to drive e:weebly downloads and open file bsa86.sav by double-clicking you will get
all 631 variables, but we only want three, v1510 v1511 and v1512. To limit the number of variables in

the active file, we use instead the SPSS GET* command:

Click on @ to open SPSS:

...and click on :

#2 1BM SPSS Statistics 19

I8N SPSS Statistics

"What would you like to do?

‘@ @:Qpen an existing data source

More Files...
C:\Users\John'Dacuments\1 Social Res

<]

C:Wsers\John\Documents\1 Social Reg
C:Wsers\John'Documents'1 Social Red

Iily)  © Open another type of file

\Documents\1 Sacial Re:
Documents’
ohmDocuments\1 S

[7] Don't show this dialog in the future

© Run the tutorial

© Type in data

© Run an existing query
O Create new

query using
Database Wizard

3 Untitled1 [DataSet0] - IBM SPSS Statistics Data Editor =B
File Edit View Data Transform Analyze DirectMarketing Graphs Utilities Add-ons Window Help
ELTIEER I'EEY FE-EEEEY

Name H Type ‘l Width H DecimalsH Label H Values H Missing H Columns H Align H Measure H Role

nllon| & fleofins] =

gl

Variable View

| ‘\BM SPSS Statistics Processor is ready ‘ ‘ | | | ‘

[Untitled1 DatasetO]

If your SPSS start-up settings don't open a new Syntax Editor on start-up, click on:

File > New > Syntax

1 IBM SPSS Statistics Syntax Editor

=]

File Edt View Data Transform Analyze Direct Marketng Graphs Utilities Add-ons Run Tools Window Help
O =

ErEL-EEy- 1 I'EE I EIYN EY |

HE 4 b7’ ©©Q MWW W — xcoefpasser]

|

[ e — | * |

—

e |
|\BM SPSS Statistics Processor is ready| | ‘Ln 1 Col 1 ‘ |NUM ‘ ‘

! format: GET '<filename>'.and the subcommand /KEEP <varlist>.

...eg: getfile 'e:bsa86.sav' /keep v1510v1511 v1512.




... and then type in: [Don't forget the primes and full stops!]

title 'Select and rename variables exercise'.
get file 'e:bsa86.sav' /keep v1510 v1511 v1512.

) *Syntax1 - IBM SPSS Statistics Syntax Editor =N E=n X%

File Edit View Data Transform Analyze Direct Marketing Graphs Utilities Add-ons Run Tools Window Help

D = ” — o —
OHEM e~ iBLINR PO 0O RH H
111 @9 WE W — e passeo]

title
get

b |title 'Select and rename variables exercise’_|
get file 'e:bsa86 sav' /keep v1510v1511 v1512.

L e

e |
| |IBM SPSS Statistics Processor is ready| ‘ \\n 1 Col 4?| |NUM| ‘
[File name changes to *Syntax1]

Click on Run > All;

= *Syntax1 - IBM SPSS Statistics Syntax Editor EI

File Edit View Data Transform Analyze Direct Marketing Graphs Utilities Add-ons Run Tools Window Help

%H%F"] &%ﬂﬂ’.(@‘i’f| Ctri+R
—=| [77= N i Selection tri+
\‘\‘ .0 ii- :Mtive:Dmsa +1To End
=B

title title 'Select and rename variables exercise'. Step Through 4
get get file 'e-bsa86 sav' /keep v1510vi511 v1512. @ Continue Shift+Tab
b -
Active DataSet 3
- o |
Al IBM SPSS Statistics Processorisready| | |In3Colo| [NUM|
#Untitled? [1 - IBM SPSS Statistics Data Editor =2 ™|
File Edit View Data Transform Analyze DirectMarketing Craphs Utiities Add-ons Window Help
0 [ == = G A
SHE M e~ BHAn By BLE 2090 “
| Name | Type | width |Decimals|  Label | Vaues | Missing | Columns|  Align | Measure = Role
1 v1510 Numeric 1 0 A105B113B R'... None 8,9 8 =Right & Scale “ Input =
2 vi511 Numeric 1 0 A106B114A R... None None 8 & Scale “w Input
3 V512 Numeric 2 0 A106B114B R... None 99 8 = # Scale  Input
4 ~]
Eii [+
Data View ' Variable View
\ IBM SPSS Statistics Processor is ready \ \ \ \ \ |
% 5
Untitled2

Adjust the column separators to see the labels more clearly:

*Untitled2 [] - IBM SPSS Statistics Data Editor \EI

File Edit View Data Transform Analyze Direct Marketing Graphs Utilites Add-ons Window Help

= —
SHe@Me~ B B BoH10% "
Name H Type H Width H Decimals” Label || Values H Missing H ColumnsH Align H Measure u Role

1 v1510  Numeric 1 0 A105B113B R'S MARITAL STATUS  None 89 8 =Right ¢ Scale “ Input !

2 v1511 Numeric 1 0 A106B114A RESPONDENTS SEX None None 8 =Right ¢ Scale N Input

3 v1512  Numeric 2 0 A106B114B RESPONDENTS AGE  None 99 8 =Right ¢ Scale ™ Input

4 -

JETI 0]

Data View  Variable View

‘ ‘IEM SPSS Statistics Processor is ready | | | | ‘ ‘

As you can see the variable labels are in UPPER CASE: they are also confusing because the
guestion number was different in versions A and B. The first part of the label combines the question
numbers from each version. There are no value labels, so these need to be added.

5



Don't blame me! | didn't write the original SPSS setup files: they came from John Curtice and his
team at Strathclyde University in 1973. I've only changed the variable names to make the file easier
to use with the questionnaire.

We also need to modify the measurement levels of v1510 and v1511. When reading the raw data,
SPSS has automatically assigned SCALE to these variables because of the range of values found
(1 - 99). This can be done with syntax?, but it's quicker in this case to do it manually in the Data
Editor.

For each variable v1510 and v1511, in the Measure column, click on Scale, then click on Nominal

Measure Measure
# Scale = " & Scale * |V
& Scale |’ # Scale  |®
4l Ordinal | .:’_l Ordinal |»
& Nominal &> Nominal
#3 *Untitled2 [] - IBM SPSS Statistics Data Editor —

File Edit View Data Transform Analyze Direct Marketing Graphs Utiities Add-ons Window Help

SHEe e~ BEENEHERL 9 S

Name | Type |Width| Decimals Label Values | Missing | Columns | Align Measure Role
1 vi510  Numeric 1 0 A105B113B R'S MARITAL STATUS None 8 9 8 = Right & Nominal ™ Input =
2 v1511  MNumeric 1 0 A106B114A RESPONDENTS SEX None None 8 =Right & Nominal “ Input
3 vi512  Numeric 2 0 A106B114B RESPONDENTS AGE None 99 8 =Right ¢ Scale “ Input
4 ~
K] I¥]

Data View | Variable View

IBM SPSS Statistics Processor is ready

Despite my predilection for positional variable names, certain variables used repeatedly in data
analysis merit mnemonic names. For demographic variables, marital, sex and age are much more
convenient to remember than v1510 v1511 and v1512. Also, for tabulation purposes, variables with
many values, such as age, need to be grouped into fewer categories. Standard practice is to keep
frequently used demographic variables together in a block, often at or near the end of the file, so that
they can be used with the TO keyword, eg sex to agegroup.

> VARIABLE LEVEL <varname(s)> (<LEVEL>)
eg VARIABLE LEVEL v1510 v1511 (nominal).



Step 3: Rename demographic variables
RENAME VARIABLES?® changes the names of variables permanently.
Type in:
rename variables (v1510 = marital) (v1511 = sex) (v1512 = age).
This command can also be written:
rename variables (v1508 v1511 v1512 = marital sex age) .
.. or, because the variables are contiguous in the file:
rename variables (v1508 TO v1512 = marital sex age) .

. . but make sure there are the same number of (implied) variables each side of the = sign.

2 *Syntax1 - IBM SPSS Statistics Syntax Editor =0 =R %"

File Edit View Data Transform Analyze Direct Marketing Graphs Utilities Add-ons Run Tools Window Help

SHEM e SELEL PO 0O & RH B
1 09 BB M — wvimmss

title: 1 title 'Select and rename variables exercise’.
get _ 2 get file 'e:bsadf.sav /keep v1510 v1511 v1512
rename variables 3 b [rename variables (v1510 = marital) (v1511 = sex) (v1512 = age ) |
ft ses |
| IBM SPSS Statistics Processor is ready| | |In3Col67 |NUM |

Run the command to get:

%3 *Untitled2 [] - IBM SPSS Statistics Data Editor =8 = "

File Edit View Data Transform Analyze Direct Marketing Graphs Utiities Add-ons Window Help

OHE G e~ BRI BREE BT 9090 5

| Name H Type u Width || Decimals” Label H Values u Missing u CnIumnsH Align u Measure H Role
1 marital  Numeric 1 0 A105B113B R'S MARITAL STATUS  None 8 9 8 =Right & Nominal “ Input =
2 sex Numeric 1 0 A106B114A RESPONDENTS SEX None Nane 8 =Right ¢ Nominal “ Input
3 age Numeric 2 0 A106B114B RESPONDENTS AGE None 99 8 =Right + Scale  Input
4 =]
ETI [r]

Data View | Variable View

‘ IBM SPSS Statistics Processor is ready ‘ ‘ ‘ | ‘ ‘

*Untitled2 after renaming variables

in the Data Editor, you can change the variable labels and add value labels manually, but this won't
yield any syntax for future reference or use, so. ..

® RENAME VARIABLES (<old name(s)> = <new name(s)>)
7



Step 4: Change variable labels

Type in: variable labels
marital 'Marital status of respondent'
/sex 'Sex of respondent’
/age 'Age of respondent'.

(2 *qy ~IBM SP y
= = = =2l = 2k oalias E@

File Edit View Data Transform Analyze Direct Marketing Graphs Utilties Add-ons Run Tools Window Help

SHEMcx ZBLAN PO 08 R W
11 A OO B W  Actve [Unnamed -

title rename variables (v1510 = marital) (v1511 = sex) (v1512 = age ) .
variable labels

marital 'Marital status of respondent’

/sex 'Sex of respondent’

/age 'Age of respondent'.

get
rename variables
variable labels

- @

e |
[ IBM SPSS Statistics Processorisready| | In8Col0 [NUM| |

Run to produce:

ies Add-ons Window Help

File Edit View Data Transform Analyze Direct Marketing Graphs

HE I« ~ Hi=h 8 B

Name H Type H Width H Declmals“ Label H Values ‘l Missing H Cnlumnsu Align H Measure H Role
1 marital  Numeric 1 0 Marital status of respondent None 8,9 8 =Right & Nominal ™ Input =
2 sex Numeric 1 0 Sex of respondent None  None 8 =Right & Nominal ™ Input
3 age Numeric 2 0 Age of respondent None 99 8 =Right ¢ Scale ™ Input
4 =
JETI Ir]

- Variable View

‘ 1BM SPSS Statistics Processorisready | | | | | |

Step 5: Add value labels

Type in: value labels
marital 1 ‘Married ' 2 'Living as married ' 3 'Separated or divorced '
4 'Widowed ' 5 'Not married '
/sex 1'Men'2'Women " [Don't forget the forward slash /]

- [ |

File Edit View Data Transform Analyze Direct Marketing Graphs Utiities Add-ons Run Tools Window Help
O F .

SRS 0 e ]

L1 QY WME | - s umanes -]

itle: 7 A /age "Age of respondent’.

get g  Ulvalue labels

rename variables 9 marital 1 'Married ' 2 'Living as married ' 3 'Separated or divorced '
variable labels 10 4 'Widowed ' 5 'Not married '

value labels 11p /sex  1'Men'2 'Women .

wen |
[ [IBM SPSS Statistics Processor is ready| | In 11 Col 17| |NUM[ |

.. and run again to get:

HE e~ BLA 8 BE B

Name: H Type H Width H Decimalsu Label ‘l Values H Missing H CulumnsH Align H Measure H Role
1 marital  Numeric 1 0 Marital status of respondent {1, Married}... 8,9 8 ight ¢ Nominal ™ Input 5
2 sex Numeric 1 0 Sex of respondent {1, Men} None 8 & Nominal “ Input
3 age Numeric 2 0 Age of respondent None 99 8 & Scale ™ Input
4

- Variable View

‘ IBM SPSS Statistics Processorisready | | | | | |

8




Step 6: Check your data

Switch to Data View: (note that the variable names have also changed in the top row):

%3 *Untitled2 [] - IBM SPSS Statistics Data Editor = |- (E]- [st3m]

Fil Ed Vier Dat Transfc Analy Direct Mar Grap Utiliti Add-c Wind Hel

.tfd Bl 8

| |V|5|ble 3 of 3 Variables

| mamal H sex || age ||
1 4 2 80
2 2 60
3 1 1 52
E—

Data View | Variable View

‘ |\BM SPSS Statistics Processor is readyl | | | ‘ |

Another way to check is:

Utilities > Variables

3 *Untitled4 [] - IBM SPSS Statistics Data Editor (= T X
File Edit View Data Transform Analyze DirectMarketing Graphs Utiities Add-ons Window Help
o Bl 0 W]

OMS Control Panel...
| Name H Type H Width H Decimals” L E* oniretFane
1 marital Numeric 1 0 Marital g OMS Identifiers..
2 sex Numeric 1 0 Sex of r{ &8 Scoring Wizard.
3 age Numeric 2 0 Age of r| [ Merge Model XML
4 q £+ Data File Comments. .
i ;
Data View i# Define Variable Sets...
@ Use Variable Sets.. —
|Vanables - |IEM SPSS Statistics e
& o Al Vari L
Highlight a variable to check its properties:

3 Variables (3] | | <2 variables 3 | | 2 variables =
| Variable Variable Information: [ Variable [|| variable information [ Variable Variable Information:
[ marital marital M marital sex o & marital age
Ep Label: Marital status of respondent i Label: Sex of respondent A |||Label Age ofrespondent

Type: F1 Type: F1 Type: F2
Missing Values: 8,9 Missing Values: none Missing Values: 99
Measurement Level: Scale Measurement Level: Nominal Measurement Level: Scale
Value Labels: Value Labels Value Labels:
1 Married 1 Men
2 Living as married 2 Women
3 Separated or divorced
4 Widowed
marital sex age

Now try Data > Define Variable Properties

This is a really useful facility as it not only allows you to edit variable properties, such as variable

2 *Untitled4 [] - IBM SPSS Statistics Data Editor = e x|
File Edit View Data Transform Analyze Direct Marketing Graphs Utilties Add-ons Window Help
% - [ Define Variable Properties. . E @ = "L*\ iﬁ . @
EQH@,‘ = Pe B i@
% Set Measurement Level for Unknown... —
. = | Label “ Values || Missir
1 maritq 18 Copy Data Properties. . Marital status .. {1, Married... 8, 9
2 sex | &P New Custom Attribute Sex of respon__ {1, Men}..  None
3 age & Define Dates... Age of respon... None 99
4 Define Multiple Response Sets...
[
Validation 3
Data View  Varia| -
EE Identify Duplicate Cases...
Define Variable Pr| 3 Identify Unusual Cases._ Statistics Processor is ready‘ ‘ | ‘ ‘ |

labels, value labels and missing values, but also gives you a count for each value found.




13 Define Variable Properties

s

™ Use this facility to label variable values and set other
:‘_ properties after scanning the data.

Select the variables to scan. They should be
categorical (nominal or ordinal) for best results. You
Variables:
& marital
6& Sex
& age

Variables to Scan:

[ Limit number of cases scanned to:

[ Limit number of values displayed to:

(o) ) ()

Highlight all three variables,

13 Define Variable Properties

. Usethis facility to label variable values and set other
properties after scanning the data.

o

Select the variables to scan. They should be
categorical (nominal or ordinal) for best results. You
Variables: Variables to Scan:
& martal
& sex
& age

[Z] Limit number of cases scanned to:

[# Limit number of values displayed to:

(o) Ccamet) o)

transfer them to the right pane

ox=

#2 Define Variable Properties

s

. Use this facility to label variable values and set other
:l properties after scanning the data.

Select the variables to scan. They should be
categorical (nominal or ordinal) for best results. You

Variables Variables to Scan

& marital
& sex
& age

[7] Limit number of cases scanned to:

[l Limit number of values displayed to:

[Cuminue][ Cancel ][ Help ]

and click on _Continue|

Again highlight each variable to check its properties. If you didn't correct the measurement levels
manually in the Data Editor, you can do so here. You can also edit the variable and value labels.

Screenshots from Data > Define Variable Properties

Define Variable Properties

Scanned Variable List

oX=

Unl_ |Me,,, ‘Rnle |Var|ab|e
]

N marital
g ¢ sex
B & M age

Current Variable: ‘marltal | Label: |Manta\ status of respondent ‘
| Measurement Level: Type: |Numeric ht -
[ Role: “w nput ¥ Width: |1 Decimals: [0 ‘

Unlabeled values: ‘2 | [ Attributes... ]

Value Label grid " Enter or edit labels in the grid. You can enter additional values at the bottom.

et
| Changed ‘ Missing ‘ Count ‘ Value Label ‘

1] =] =] 2059 1 Married

2| ] 81 2 Living as married

3] [l 164 3 Separated or divorced

4] [&] 284 4 Widowed

5] 0 502 5 Not married

6 I 0

71 ] I 10 9

-8 a 5]

Kl

A1

Cases scanned

Value list limit:

Copy Properties

Unlabeled Values

[Emm Another Variable... ]

[ To Other Variables...

Automatic Labels

(oc ]

marital
tP Define Variable Properties @
Scanned Variable List Current Variable: |sex | Label: ‘Sex of respondent ‘
Unl.. ‘Me,,, |Rnle |Vanab\e Measurement Level: |¢ Scale = || S : i -
- - uggest | Type: Numeric — ~
A N martal =] — L
[m] sex Role: N Input T Width: [1 Qecimals:D
B & M age - P
Unlabeled values: |D | [ Attributes. . ]
Value Label grid: ’i‘ Enter or edit labels in the grid. You can enter additional values at the bottom.
| Changed ‘ Mi g ‘ Count ‘ Value Label ‘
1] O ] 1445 1 Men
2] & @] 1655 2 Women
3] ] ]
Eni IO
Copy Properties Unlabeled Values
Cases scanned: EYRC
Value list imit [Emm Another Vanabte...] [Tg Other Vanabtes...] Automatic Labels
sex

10



Values 8 and 9 have been declared as missing for marital, but are not labelled: there are no missing
values for sex

#2 Define Variable Properties @
Scanned Variable List Current Variable:  |age Label: ‘Age of respondent |
unl... ‘Me,,, ‘Role |Vanab\e Measurement Level: ¢ Scale = || Sug z

| E gest| Type: |Numeric ™ -
A : marital =~ = ype: | ‘ ‘
(] SEX Role: Width: |2 Decimals: |0
B & N age - e
Unlabeled values: [ Attributes. .. ]
Value Label grid- 4“ Enter or edit labels in the grid You can enter additional values at the bottom.
Changed ‘ Missing ‘ Count ‘ Value Label ‘
1 O O 76 18
2] | 8 53 19
3] O a 58 20
| 4] | ] 56 21
5| | a 64 22
|6 | O a 64 23
|7 ] T 0 85 24
-8 | a a 51 25
|9 | T 0 47 26
L[ 10/ | =] 48 27
] ] a 57 28
[E1 [F] — —
Copy Properti Unlabeled Values
Cases scanned: (3100 PIFCEEE
(Erom Another Variable..| [ To Other Variables... | Automatic Labels
Value list limit: {200

 {camel 1o

age

Scroll to the bottom to see top range of values for age, including 99 declared as missing

%3 Define Variable Properties @

Scanned Variable List Current Variable: Label: ‘Age of respondent |
Eﬂ-- ‘ME-)-- ‘Role |Var|ab|e L Measurement Level: Type: Numeric - o
= 4

$ : marital (<] E‘
[m] sex Role: Width: |2 Decimals:
B & N Boe ] -
Unlabeled values: [ Aitributes._. ]
Value Label grid- q‘ Enter or edit labels in the grid. You can enter additional values at the bottom.
Changed ‘ Missing ‘ Count ‘ Value Label
68 ] | 8 85
69 ] | 3 86
10/ O O 4 87
71 O T 5 88
12 a a 2 89
73 o T 3 90
74 0 0 1 91
18] O O 1 92
76 | | 1 97
= aaa O Il 3 99
A oy 2L -
Copy Pr i Unlabeled Values
Cases scanned: -3100 Fy o ] [ ] ’V
From Another Variable. To Other Variables._. Automatic Labels
Value list limit: fom 2

age
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Step 7: Save your active file

Once you are happy with everything, you need to save your active file and your syntax.

Go back to your Data Editor:

=

132 #Untitled2 [] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze DirectMarketing Graphs Utiities Add-ons Window Help

= —
SRl e~ BLAREE BLH 10% 6
| Name || Type “ Width || DecimalsH Label H Values H Missing ‘CnlumnsH Align H Measure H Role
1 marital  Numeric 1 0 Marital status of respondent {1, Married} . 8,9 8 =Right & Nominal “ Input
2 sex Numeric 1 0 Sex of respondent {1, Men}... None 8 =Right @ Nominal ™ Input
3 age Numeric 2 0 Age of respondent None 99 8 =Right ¢ Scale ™ Input
4

4]

Data View | Variable View

IBM SPSS Statistics Processoris ready | | | ‘ ‘ ‘

.. and click on File > Save As

BN Ao >

*3 *Untitled2 [] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Direct Marketing Graphs Utilities Add-ons Window Help

New 3 E= p Al
. BEIPF A B ELE LS00 %
pen
- Label || Values || Missing || Columns H Align || Measure
Open Database 3 . N — "
@ - Marital status of respondent {1, Married}... 8,9 8 = Right &5 Nominal
e Sex of respondent {1, Men}... None 8 Right & Nominal
@ Read Cognos Data... Age of respondent None 99 8 = Right & Scale
(38 Close Ctrl+F4
= Save Ctrl+8
Save As...
IBM SPSS Statistics Processor is ready \ \ | \ | ‘

b Save All Data

Navigate to e:weebly downloads and change the file name from [Ejglijizlsf2 to bsa86renamel.sav

Save Data As 3 Save Data As -
Lookin: | | Weebly downloads A Lookin: | | Weebly downloads - @
[ bsag6 sav (i bsa8h sav
fifthx sav fifthx. ;av
myclass sav myclass sav
newbsag9.sav newbsa89 sav
(5 ql4gb1975 sav (= ql4gb1975.sav

Keeping 3 of 3 variables. Keeping 3 of 3 variables.
S File name: ‘bsaBGrenamﬂ

Save as type: ‘SPSS Statistics (*.sav) Save as type: ‘SPSS Statistics (*sav)

e | (e
ariable names to spreadsheet @ riable e: preadsheet E

efined instead of data values

File name: ‘ummedz

vels into a sas file
[7] Encrypt file with password

[l Save value labels into a _sas file
[Z] Encrypt file with password

Store File To Rej Store File To Repository...

and press :

The file will be saved as bsa86renamel.sav on drive €e:
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ESNE=E =

@GD-M » Computer » COOLMATE (E) » Weebly downloads

Organize ~ Share with ~ Burn New folder
“  Name Date modified Type
‘& Computer .
& Local Disk (C) !,E bsa86 05/06/2013 12:.07 SPSS Statistics Dat...
Z- Local Disk (C: ’
COOLMATE (£ !,a fifthx 05/06/2013 12:20 SPSS Statistics Dat...
“’i S : : !,a myclass 05/06/2013 12:21 SPSS Statistics Dat...
ee own ,
= );I = !:Q newbsa89 05/06/2013 12:19 SPSS Statistics Dat...
- Removable Dis| ’
; f s (G) i !,a qldgb1975 03/06/2013 19:37 SPSS Statistics Dat...
ements (G:
SANDISK (B) bsa86 05/06/2013 09:43 TXT File
“_’ R (k') bsa89 05/06/2013 11:17 TXT File
= ' myclass 05/06/2013 11:17 TXT File
. !,a bsa8brenamel 05/06/2013 17:54 SPSS Statistics Dat...
@ Network Ll
l 9 items

v|¢¢ || Search.. P |

= O @
Size

2,053 KB
61 KB
TKB
3,273 KB
601 KB
3,304 KB
3,824 KB
7KB
10KB

Step 8: Save your syntax

Go to your back to your Syntax Editor:

2 *Syntax1 - IBM SPSS Statistics Syntax Editor

File Edit View Data Transform Analyze Direct Marketing Graphs Utiliies Add-ons Run

SN HEm =

Tools Window Help

SHEM e« "BHI R PO 00 & B H

1 T4 -

title: 1 title 'Select and rename variables exercise’. 3
get 2 get file 'e:bsa86.sav' /keep v1510v1511 v1512.
rename variables 3 rename variables (v1510 = marital) (v1511 = sex) (v1512 = age ) .
variable labels 4 variable labels
value labels 5] marital 'Marital status of respondent’

53 /sex 'Sex of respondent’

7 /age 'Age of respondent’.

3 value labels

9 marital 1 'Married ' 2 'Living as married ' 3 'Separated or divorced '

10 4 "Widowed ' 5 'Not married '

11 /sex 1'Men'2'Women ' =

v |

\ [IBM SPSS Statistics Processor is ready| | [In12 Col 0] [NUM]| \

File > Save As

=2 *Syntax1 - IBM SPSS Statistics Syntax Editor
File Edit View Data Transform Analyze

= B

Direct Marketing Graphs Utilities Add-ons Run Tools Window Help

New »
Qpen »
Open Database »
(& Read Text Data...
(38 Close
H Save

Ctr+F4
Ctr+S

Save As

Display Data File Information 3
@ Stop Processor Ctrl+Period
% Switch Server...

Repository 3

Page Setup
& Print
|5 Print Preview

Ctrl+P

LB N PO VGG R E

lect and rename variables exercise'.

'bsa86 sav' /keep v1510 w1511 v1512.

rariables (v1510 = mantal) (v1511 = sex) (vi512=age ) .

abels

Marital status of respondent’

of respondent’

& of respondent'.

els

tal 1 'Married ' 2 'Living as married ' 3 "Separated or divorced *
4 "Widowed ' 5 'Not married '
1'Men' 2 "Women '.

=

-~

IBM SPSS Statistics Processor is ready| | |In 12 Col 0| [NUM|
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Navigate to e:weebly downloads

(3 Save Syntax As @

Lookin @ B3 =

File name: ‘Symam | I Save I

Save as type: ‘Symax(',sps) — | Canc

Encoding: ‘Unvccde (UTF-8) = | m
Store File To Repository.

(L Save Syntax As @
Lookin @ Ei =
File name: |bsasﬁrenameﬂ ‘ [ Save ]
Save as type |Syntax (* 5ps) N ‘ m
Encoding' [Unicode (UTF-8) B M
Store File To Repository.

No, you haven't lost your *.sps file! It's not shown because SPSS is checking for the presence of
other *.sps files in folder e:weebly downloads and there aren't any yet. It's waiting for further

instructions. [ SsesyEAs appears at top left. Change the name from | Syntax1| to | bsa86renamel

and click on :

= e )

Organize ~ Share with ~ Burn New folder
i Name
& Computer
24 bsa8b
& Local Disk (C2) gf'f‘th
24 fifthx
<> COOLMATE (E) @ |
28 myclass
| . Weebly downl @ Y _—
24 newbsa
= Removable Disk @ VT
EE Elements (G:) : ?36
sa
= SANDISK (L) beag9
sa
<> FASTTAB(K) |_ |
3 myclass
, \,_i! bsa86renamel
@ Network —
| 5 bsa86renamel
10 items

@Ov|. » Computer » COOLMATE (E:)) » Weebly downloads

Date modified

05/06/2013 12:07
05/06/2013 12:20
05/06/201312:21
05/06/2013 12:19
03/06/2013 19:37
05/06/2013 09:43
05/06/2013 11:17
05/06/2013 11:17
05/06/2013 17:54
05/06/2013 17:39

Type

SPSS Statistics Dat...
SPSS Statistics Dat...
SPSS Statistics Dat...
SPSS Statistics Dat...
SPSS Statistics Dat...

TXT File
TXT File
TXT File

SPSS Statistics Dat...

SPSS Statistics Syn...

v | +3 || Search ol |

=~ 0 @

2,053 KB
61 KB
7KB
3,273 KB
601 KB
3,304 KB
3,824 KB
7KB

10 KB
1KB

Your syntax file has now been saved in folder e:weebly downloads

End of exercise:

2.3.1.2al Select and rename variables

You can close the saved file and exit SPSS now or leave it open and go straight to the next exercise

Next exercise:
Back to page:

2.3.1.2a2 Recode into new variable

2.3 Data transformations

[Back to Block 2 menu]

14



http://surveyresearch.weebly.com/uploads/2/9/9/8/2998485/2.3.1.2a2__recode_into_new_variable_exercise.pdf
http://www.weebly.com/weebly/main.php
http://surveyresearch.weebly.com/block-2-analysing-one-variable.html

